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The ESO Recipe Flexible Workbench
EsoReflex

Enrigue Garcia Dabo, Andrea Modigliani,
Artur Szostak, L. Coccato

http://www.eso.org/sci/software/pipelines/reflex_workflows
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Overview
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* Basic concepts

* Implementing a workflow with EsoReflex
components

* EsoReflex python library functionality

* Frequent tasks to debug EsoReflex
workflows
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+E©§+ EsoReflex Workflow Basics (1)

.

* A workflow is a set of connected actors that
represent a pipeline data reduction cascade as
encoded in OCA rules.

 Each actor is an independent step, e.d. recipe
processing step, interactivity element, data source
or data sink.

* Connections between actors indicate how output ports
from one step are connected to input ports for the next.
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+E©§+ EsoReflex Workflow Basics (2)

.

* The underlying compute engine passes around tokens in
sequence from one actor to the next over the connections.

 Tokens are associated with data and can have different
types. The most common for Pipeline workflows are SOFs
and SOPs.

* An actor will typically only execute when it has received one
token on every input port, and will produce an output on all
Its output ports.
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Typical workflow GUI layout

File Edit View Workflow

Tools

file:/home/cgarcia/spDbiare]

window Help

e« el |

CAIE = 2ibAIR S

instrume. . .nstrum

Main configuration

5014/examplrefiex/exam. xmi

Search Components

Components | Data | Outline 4 workflow |

search |

[advanced s...| sources |

cancel |

All Ontologies and Folders

= [ Components
o [§ Projects

o [ statistics

o [ Demos

o [ Actors

& [ Dataturbine
o= [ Directors

o [ Eso-reflex
o [ Job

o [ MyWorkflows
o [ Opendap

o [ outreach
[ R

DOF Director

Exam

[ Workflow Instructions

I

Setup Dire

Global Parameters

To run this workflow on the demo data:

- Turn on highlighting. Choose
nd set it to "1
- Press the "Run” button OR cntrl-R to start the workflow.

To run on a different data set:
- Click on ROOT_DATA_DIR and set as appropriate.

All subdirectories of RAW_DATA_DIR will be searched for data.

- If desired, change END_PRODUCTS_DIR.
- Press the "Run” button OR cntrl-R fo start the workflow .

To monitor the progress of the workflow in more detal
- Open “Window" -> "Runtime Window" in top menu before
starting the workflow .

Tools"-> “Animate at Runtime™

Input:
& ROOT_DATA_DIR: ROOT_DATA_PATH_TO_REPLACE/

o RAW_DATA_GIR: SROOT_DATA_BIRfreflex inputfeam

& CALIB_GATA_OIR: CALIB_DATA_PATH_TG_REPLACE/ekam 0,101

Working Directories:
& BOOKKEEPING_DIR: $ROOT_DATA_DIRjrafiex book_keepingfesam
© LOGS_DIR: SROOT_DATA_DiRyreflex_logs/exam
© TMP_PRODUCTS_Dift: $ROCT_DATA_DIR/reflex_tmp_products/exam
Output:

© END_PRODUCTS_DIR: $ROOT_DATA_DiRjrefiex_end_products

@ RecipeFailureMode: Ask

Glabal parameter for the behaviour when a recipe fais
'Ask' means that each time a recipe fails, the choice to

continue or stap wil be presented. ‘Cantinue’ means that

the workflowr will ignore erors and continue.
ve will stop.

Change “Erase true’ o eras

BOOKKEEPING_DIR, TMP_PRODUCTS_DIR and LOGS_DIR

each time the

the war

* EraseDis: false

Stop’ means

Dirs" to U

workflow is run iLazy Mode will not work anymore)

fits Viewer to use for the

@ FS_viEwEeR: fu

inspection of inputioutput
ducts

Disable interactive GUIs for the whole workflow

®GilobalPlotinteractivity: true  Quarrides in subworkflows have precedence.

General
Information

@ SelectDatasetMethod: Interactive

0 results found.

=

@ ProvenanceexplorerEnables: true

Selaction methad for the Data Set Chooser

Show Provenance Explarer window

Step 1:
Data Organisation
and Selection

Step 2:
Creation of Master
Calibration Files

H

Step 3:
Science Reduction

Step 4:
Output
QOrganisation

SofCombiner2

- .{_p—%l

Cabbration

SofCombiner

i Laset ProvenanceEmirer
cumert dase % i il

(wsiiary ana debup paremeters. please 3o ot change

& GLOBAL_TIMESTAMP: 2014-10-207T1

ESDReiArgs: —5Uppress-prefic=TRUE

& END_PRODUCTS_SUBDIR: 2014-L0-20T11:38 42/EXAM 2007-03-01T03:12 34 AINSELECTED_DATASETS: 1)

1

Canvas with main actors
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Designing a workflow (1)

e Steps previous to use Reflex:

Design modular pipelines: i.e. with recipes performing granular
tasks. Avoid cases where 1/O of the recipes depend on recipe
parameters.

Think about the supported observing modes. Optional calibrations
sometimes imply quite different reduction cascades.

Start with an stable version of the pipeline I/O and parameters.
Carefully design the FITS file categories.
Design the workflow layout in paper
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Designing a workflow (2)

e Steps using Reflex tool:

* Create Data Organisation rules (OCA rules) which mimic the
workflow layout as closely as possible

* Use a workflow template (iiinstrument)
* Create the graphical workflow layout

* SKkip interactivity development until the end.
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Data Organisation: OCA rules

* OCA rules are the mechanism used to perform Data
organisation in a Reflex workflow

* OCA rules and workflow graphical layout are closely related.
* OCA rules are written in a text file with a given syntax.

* There are three types of rules:

» Classification. Based on FITS keywords, it specifies the category of
the file we have (“I am a raw flat”)

* Organization. Files are grouped by keywords and each group triggers
an action (“These flats create a master flat”)

e Association. Each action can associate static calibrations or products
created by other actions (“To create a master flat | need a master bias®)
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Data Organisation: OCA rules

e Classification:

if DPR.CATG like "%SCIENCE%" and DPR.TYPE like "%OBJECT%" then

{
REFLEX.CATG = "RRRECIPE_DOCATG_RAWY,

REFLEX.TARGET ="T"

if DPR.CATG like "%CALIB%" and DPR.TECH like "%IMAGE%"
and DPR.TYPE like "%STD%" then

REFLEX.CATG = "RRRECIPE_CALIB_DOCATG_RAW",
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Data Organisation: OCA rules

e Organisation:

select execute(CALIB_IMG) from inputFiles where REFLEX.CATG == “RAW"”
group by INS.FILT1.NAME, OBS.ID, OBS.TARG.NAME, TPL.START,;
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Data Organisation: OCA rules

e Association:

action CALIB_IMG

{

minRet = 0; maxRet = 1;

select file as STATIC_MASK from calibFiles where REFLEX.CATG == "STATIC_MASK";

recipe rrrecipe_calib;

product IMG_CALIBRATED { REFLEX.CATG = "IMG_CALIBRATED"; PRO.CATG = "IMG_CALIBRATED"; PRO.EXT="tpl_0000.fits";}
}

action COMBINE_IMG

{

minRet = 1; maxRet = 1,

select file as IMG_CALIBRATED from calibFiles where PRO.CATG == "IMG_CALIBRATED";

recipe rrrecipe;

product IMG_OBJ_COMBINED { PRO.CATG = "IMG_OBJ_COMBINED";PRO.EXT="tpl_0001.fits";}
}
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File Purpose
+

* Category is not enough to determine the use of a file.

* The Purpose is the role a file will have in the reduction cascade => Path in the
association tree

* A given file can have a list of purposes.

* For example, a raw BIAS might have purpose MASTERBIAS/SCIENCE if it's going
to be used to produce the master bias that will be used to reduce the science
frames. S

Select Frames 4+ 0O =
[ | | Category

DVIMOS.2011—05—02T01:47:52.775.fit9 IFU_SCIEMCE

D MAWVIMOS, 2011-09-21T11:19:10.61 4. fits CCD_TAELE

[ MvIMOS. 2008-06-17T18:12:53.1 76.fits
¢ [CJBlAS

EXTINCT _TAELE

L

FuU_CaL

[ vIMOS. 2011 -05-02T02:50:58.533. fits
[ vIMOS. 2011 -05-02T02:45:06. 324, fits
[ WIMOS.2011-05-02T02:47:05.245.fits
[ wIMOS. 2011 -05-02T02:49:04, 260.fits

3 WIMOS, 2011-05-02T11:06:26,259.fits BlAS
3 WIMOS, 2011-05-02T11:07:18.075.fits BlAS
3 WIMOS. 2011-05-02T711:08:10.072.fits EBElaS
3 WIMOS. 2011-05-02T11:09:01.078.fits El&S
3 WIMOS, 2011-05-02T11:09:52,082.fits BlAS
3 MAWIMOS, 2011-09-21711:19:10.61 4.fits CCD_TABLE

IFU_ARC_SPECTRUM
IFU_SCREEM_FLAT
IFU_SCREEM_FLAT
IFU_SCREEM_FLAT

[ MWvIMOS. 2011-09-21T11:19:10.61 4 fits CCD_TABLE
[ MAWvIMOS. 2010-08-19T16:15:02.809.fits LINE_CATALOG
[y ifu_ident_HR_blue. 2.fits IFU_IDENT
% CIdBIAS
[y wIM0S.2011-05-02T11:06:26.259.fits BIAS
[ wiM0S.2011-05-02T11:07:18.075.fits BIAS
[ wiM0sS.2011-05-02T11:08:10.07 2.fits BlAS
[y wIM0S.2011-05-02T11:08:01.078.fits BIAS
[y vIM0S.2011-05-02T11:09:52.082.fits BIAS
[ MAvIMOS.2011-09-21T11:19:10.61 4.fits CCD_TABLE

FENEENYEEENEEEE SRR R RREREG

o [ STD_IFU
Select All I Deselect All

Save as...

Inspect
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0 How to search for components
+

Search Components

display Search

The search components utility allows
to filter the available components by

All Ontelogies and Folders -
c Nname.

Advanced 5... SouUrces Cancel

L Search Results

¢ L Components
¢ Data Qutput

O ot The EsoReflex folder contains all the
monserereoeria - EsoReflex specific actors developed
b Textonl o P for astronomical reduction.
Browser Display
kY Disp_lay _ .
s rrocts PR To use them, simply drag and drop.
" oo ity (except for recipe executer)
! 9 ij]tz;ieﬂctors.kar
|| Erowser Display
Display

Il ESRI Shape File Displayer
H P play

| GML Displayer
[ Image Display
WY Multiple Tab Display
QMview Display
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Each actor comes with documentation

Display

* The documentation explains which
should be the functionality of the actor

E Configure Actor

Customize Name
Configure Ports
Configure Units
Open Actor

Get Metadata

Ctrl-E

and the format used by the input and
output ports.

cutt  Actors documentation accessible

Documentation

oy already on results from a search

_l_ Listen to Actor

Canemmembis Torm o Aemem ok skine

Custom
p) Remove

== < Documentation is available for most
actors
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Main EsoReflex components (1)
+

DDF Director: Drives the workflow engine
DataOrganiser: organise, classify, associate data
DataSetChooser: allows the user to selects data sets

FitsRouter: sends data through different paths

DDF Director Da

Organiser Data SetChooser %1
m'__ K:}E{IFNFF

l ‘Lu

=)

L
2]
o
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+E+S+

0 Main EsoReflex components (2)
+

SofCombiner: combines SOFs based on purposes.

ProductRenamer: renames final products (based on relevant
FITS keywords)

DataFilter: to select and inspect (if FITS VIEWER Is set) data
Interactively

SofCombiner

sof in 1
sof out
sof in optp — A
n

DataFilter

ProductRenamer sof out

L

sof in
sof rejected
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Reflex Actors: DataOrganizer

.

* The DataOrganizer is responsible of giving each input file a
category and purpose.

* It Is configured by means of a OCA rules file

=

I BE
OCA File: Jusrfsharefesopipes/fors-5.4.5/reflex/fors_spec_wkf.oca " Browse
Keywords to be displayed: OBS.TARG.NAME,INS.GRIS1.NAME,INS.FILT1.NAME,INS.MASK.ID,

Lazy Mode:

Use CalSelector associations: [

Association preference: NONE -

Bookkeeping Dir: $BOOKKEEPING DIR | Browse Configure

class: org.eso.DataOrganizer Configure
Commit | | Add | | Remove | | Defaults | | Preferences | | Help | | Cancel |
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DataOrganizer Lazy Mode

* Lazy mode for DataOrganizer.

— It avoids the organization of all the data in subsequent workflow
runs.

- It checks whether the OCA rules and the input files are the same.
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Reflex Actors: FitsRouter

* The FitsRouter will split the input by 5 "-‘*‘%
category.There are two modes: [ vy

* Routing by category explicitly. Just create a port with the name of
the category.

e Configuring a port. Create a configuration parameter with the name
PORT _config and list the desired categories.

* The ,sof rejected” ports can be a usefule debug tool

@ class: org.eso.FitsRouter || Configure
_hideName: true
SCIENCE_config: |"RAW,BPM"
CALIB_config: FLAT

Commit | | Add | | Remove | | Defaults | | Preferences | | Help | | Cancel
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Reflex Actors: DataSetChooser
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* It allows to select the Datasets to reduce
e Datasets can be inspected and the calibration cascade will be shown.,
* Purposes can be seen as the path to the leaf in the tree

* If a Dataset is incomplete, it will show which are the missing files.

Select Datasets

Selected Data Set #Files [ol=1]= SElecrirames
L ILNVES. 2008-10-26T00: 24: 47, 790 125|95gr [ sel | Category Keyword Value
7 WES. 2009-01-21T032:41:558. 062 126|HENDG32-034 D UVES, 2008-10-26T00: 24:47 790, fits SCI_POINT_RED ~| SIMPLE T =
= . SR [y U GEXT 0210134 extcoeff table.fits EXTCOEFF TAELE BITPIX 16
4 VES, 2008-02-04T00:47:11.636 125))051624.60-8 ¢ 9 oRDERDEF ECH RED MAKIS o
] UVES. 2008-02-123T00:57:52. 546 122 RM-LMC-2008 [ UVES. 2008-10-26T1 2:40:55.030.fits ORDER_FLAT RED E}I’;—:-(IBEINND Eso T
— 9 CJEIAS_RED 0a- .
4 UVES, 2008-03-11T07:20:35.648 85|1E5-1553+1 [ UVES. 2008-10-26T1 1,51, 26.797.fits BlAS_RED ?SLTEESCOP égg?ﬁiﬁ;n“‘*“ | |
e INVES. 2009-03-13T04:00:31,.835 1268|Hen-3-847 %UVES-2008-10-26T11:52:13-602fits BIAS_RED INSTRUME  |UVES
=] T UVES.2008-10-26T11:53:00.365 fits BIAS_RED ORJECT BIAS
Ld UVES.2008-03-20T05:03:08. 533 85|LTT-4316 [} UvES.2008-10-26T11:53:47.180 fits BIAS_RED Rl 130.295990
UWVES, 2008-04-05T08:43:47, 822 1256 |HR7355 [} UVES, 2008-1 0-26T11:54: 34,544 fits BIAS_RED DEC -32.61643
o [ FMTCHK_ECH_RED EQUINOX 2000,
— [} UVES. 2008-10-26T1 2:38:53,009.fits ARC_LAMP_RED | =|m ;
Missing MASTER_FLAT REDL WEF [} Uv_GLRE_D702224 line_refer_table.fits LINE_REFER_TABLE E‘LDTE,%SBS ggggiéfﬁﬁfém
Missing MASTER_FLAT REDU WEF 9 Ij%QS_RED uTC 42726.000
P = z T UWES.2008-10-26T11:51:26, 797 fit O BIAS_RED LST 34283.068
M!SS!HQ ORDER—GUESS—TAB—REDL—WKF [ UvES. 20081 0726T11:52:13.602‘f:t2 BIAS_RED FI-Cal UVES Operation T...
Missing ORDER_GUESS_TAB_REDU _WkF [} UvES.2008-10-26T11:53: 00,395 fits BIAS_RED CBSERVER
Missing LINE_GUESS TAE_REDL WkF [ UVES.2008-10-26T11:53: 47,189 fits BIAS_RED ORIGFILE UVES RED BIASS. .
P - = ~ T [ UVES. 2008-10-26T11:54: 34,644 fit: EIAS_RED ARCFILE UVES.2008-10-26...
Misging LIME_GUESS TAB REDU WEF -G OARK RED e e - uT 11:52:06.000
. ST 09:31:23.068
o 9 EFLAT ECH RED .
o ] ORDERDEF_ECH_RED ﬁm;ﬁil: élggooo
o [ FMTCHK_ECH_RED HIERARCH.E ... [ES0VLT-DIC. OBS-..
o [ BIAS RED I HIERARCHLE... [0
o 7 DARK_RED [ HIERARCH.E... | 200115615 =

Select All | Deselect All ‘

Save as...
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Reflex Actors: RecipeExecuter

* [t executes recipes using esorex
* The RecipeExecuter has to be instantiated explicitly:

Tools -> Instantiate Component. It needs to have the recipe
Installed (i. e. it is shown in esorex —recipes).

* For each recipe parameters, an actor parameter is created
with the name “recipe_param_nn’", where nn corresponds to
the parameter order.

* If recipe parameters change, the RecipeExecuter should be
reinstantiated.
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RecipeExecuter: Recipe parameters

.

recipe_param_1: debug=FALSE
recipe param_2: plotter=no

recipe param_3: process chip=hoth
recipe_param_&: mbox x=FORT
recipe_param 5: mbox y=PORT
recipe param_6: trans x=PORT
recipe_param_7: trans y=FORT
recipe param_8: ech_angle off=0.0
recipe_param_9: cd_angle off=0.0

Some parameters are set to PORT and changed via the sop
port. Other parameters however have fixed names and values.
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RecipeExecuter: Other configurations

recipe: espdr_mdark

mode: Run El
Lazy Mode:

Recipe Failure Mode: $RecipeFailureMode T o
Input Files Category: DARK,CCD GEOM,INST COMFIG MASTER BIAS RES =

Output Files Category: HOT PIXEL MASK MASTER DARK

* Using input filters one can select the file categories that are
passed to the recipe: DARK,MASTER_BIAS RES,...

* With output filters one can select the file categories that are
broadcast to the sof out: MASTER_DARK,
HOT_ PIXEL MASK
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RecipeExecuter: Lazy Mode

* Lazy mode for RecipeExecuter

- It works by comparing the input of the current execution with all the
previous recipe executions:

* All files must be the same

* All files must have the same checksum
* All files must have the same date

* All recipe parameters must be the same

- If arecipe at the beginning of the workflow is set to Not-Lazy mode,
the input of the next recipes will be new and lazy mode will not be
triggered.
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JES+ Recipe actors: SofSplitter &

% SofAcumulator

* In order to handle properly Purposes, the RecipeExecuter's have to be
enclosed between SofSplitter/SofAccumulator.

» SofSplitter will create as many groups as different purposes are in the input
and will trigger the RecipeExecuter for each of the purpose groups.

* For example: Biases that are needed to calibrate the science
(purpose=bias/science) will be processed separately from the biases
needed to process the standard star (purpose = bias/standard)

» SofAccumulator simply combines back all the products in a single channel.

rrrecipe_calib_1

_ SofSplitter SofAccumulator
sof in 1 . 1

>

sof out

> sof out -
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Recipe actors: ProductExplorer

.

* It displays the effective reduction cascade used to create a given
product.

o Product Provenance + 0 X

Search products Provenance Tree | Category
9 [ exam_lacosmic.fits COSMIC_REMO

O Last [ bpm fits BPM

Al D EXAM.2007-09-01T03:12:34.444 fits AW
@ From [22/10/14 18:53:09 ? D master_bias.ﬂts MASTER_B|AS
9 ] MASTER_FLAT.fits MASTER FLAT

T 221014 18:53:22 - -

° 110/ ¥ D EXAM,2007-09-01T10:48:02.138 fits FLAT
Search [y master_bias.fits MASTER_BIAS

D EXAM.2007-09-01T10:48:35.192.fits FLAT

Dataset [
9 CIEXAM.2007-09-01T03:12:34.444 tpl  2014-10-22
D _UNEMOWMN__COSMIC_REMOWVED. fits
D _UNKNOWMN__COSMIC_MASK.fits

Il [ Ir

k
Inspect

< il [r4]
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Reflex actors: SofCombiner

+

* The SofCombiner takes as input a number of set of files and
combines them into one set of files that contains only the files
whose purposes are present in all the input tokens.

* With this respect empty tokens are ignored and files with
universal purpose are always collected.

* Not to filter out inputs with different purposes, use option
“ignore purposes” (or use sof in opt).
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0 The diamond

.

To connect the output of a single port to several actors, the
diamond will send the output to several connections

Final message

Display Current Dataset

—{l)

;“M—\—o—c} $END_PRODUCTS_DIR

~—q> $GLOBAL TIMESTAMP !L-
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*E@? : Reflex actors: CompositeActor

.

* It is used to create nested workflows.

* In the standard workflows there are quite a number of
composite actors

* The inner subworkflow can see the variables from the top
level one

* The ports of the CompositeActor in the upper workflow
appear as floating sinks or sources: = =& > 5>

ProductExplorer

. b
Closg DataSet
set
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Reflex actors: RecipeLooper

ForsCaliblnteractivity

out sop loop

i ouk

sof o
12

out sof loop

@ [I_ ___I |-

sof out

Setinteractivity

$Enablelnteractivity

@ INIT_SRADIUS: 10.0
o INIT_DRADIUS: 10.0
o INIT_S_NKNOTS: -1

o INIT_D_NKNOTS: -1

Createlnitia|SOP

sof in

= e INIT_SPLFIT THRESHOLD: 0.01
i o INIT STACK METHOD: sum

soflin ® INIT_MINREJECTION: 1

e INIT_MAXREJECTION: 1
o INIT_KITER: 999
o INIT_KLOW: 3.0
@ Enablelnteractivity: $GlobalPlotinteractivity ® INIT_KHIGH: 3.0
e INIT_ WREJECT: 0.7
o INIT_WMODE: 2
o INIT_WMOSMODE: 0

o INIT_WRADIUS: 4
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Reflex actors: PythonActor (1)

+

* It Is able to execute generic python code.

* To translate from/to Reflex ports to/from python script
arguments a special syntax is used, with the help of a Python
module

* To create a python actor, use the menu Tools->Instantiate
Component and type org.eso.PythonActor.
*The script must import reflex.py module

*Stand-alone execution is possible (executing cmdline.sh in
proper dir)
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Reflex actors: PythonActor (2)

* A python script can be “reflexed” using the following syntax:

from reflex import *

arser = ReflexlOParser() .
P U Importlng REﬂEX
#Define inputs

parser.add_option("-i", "--in_sof", dest="in_sof") \

#Define outputs

. Define Inputs/Outputs

parser.add_output("-0", "--out_sof", dest="out_sof")

(inputs, args) = parser.parse_args() Gettin g inpu ts
outputs = parser.get_outputs()

#Set the output -

outputs.out_sof = inputs.in_sof Setting outputs

parser.print_outputs()

sys.exit()
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Python Framework
+

* Reflex is delivered with a python library that helps to create
Interactive user interface rather easy using matplotlib and
wxPython.

* The reflex_interactive_app module is a framework to create
Interactive windows.

* The pipeline_product module eases the reading of FITS
Images, spectra and tables, using pyfits.

* The pipeline_display module produces scatter plots, image
displays and spectra plots using matplotlib.

* The reflex_plot_widgets module allows to add extra
Interactivity within the matplotlib plots.

* These modules are accessible directly when using a python
script inside the PythonActor.
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Python Framework

* Example of using reflex_interactive app framework:

def setinteractiveParameters(self):

return [reflex.RecipeParameter(recipe=rec_name, displayName="parl", group="Limits"]

Defining the recipe

def readFitsData(self, fitsFiles): parameters to show
self.frames = dict() Reading the FITS
for f in fitsFiles: Data from the input

self.frames]f.category] = PipelineProduct(f)
pro_raw = self.frames[*MY_CAT"]

pro_raw.readimage()

def addSubplots(self, figure): Defining the plot
self.raw_plot = figure.add_subplot(111) layout

def plotProductsGraphics(self):
img_raw_disp = pipeline_display.ImageDisplay()

img_raw_disp.setLabels('X', 'Y") :
Plotting the data

tooltip = paragraph("Raw image")

img_raw_disp.display(self.raw_plot, "Raw image", tooltip, pro_raw.image)
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By middle-clicking within one of these region
you select an extracted spectrum,

which will be plotted below.
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xamples interactive windows
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Examples interactive windows

m - ESPRESSO Interactive Workflow: Science Reducti ~
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Debugging workflows




B How to verify/debug OCA rules

+

* Check for typos in FITS keywords used to classify, associate,
constrain data.

* Have data for which REFLEX. TARGET is defined

* Grey data sets:
1)Pointing mouse give information (missing PRO.CATG).
2)search in the OCA rules which recipe creates it,
3)Search what raw data triggers that recipe,

4)Add missing data to RAW DATA DIR/CALIB_DATA DIR.
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How to verifyldebug OCA rules

+

* To inspect the data set can help

* The OCA rules define the reduction chain. They define the
workflow layout.

* Make sure that RAW data types and PRO.CATGs are
unique.

* You may use minRet/maxRet to constrain trigger of events
and associate master calibrations.

* You may define RAW TYPES to group data types together

=S SRR IR R R —i - fo=p )+ ™



ES+
"0

Debugging using the text display

+

Using a text display is the very useful way to inspect a workflow
and see the information which travels through it.

The text display will pop up a window the first time it is
triggered.

MonitorValue actor may be used to display most recently
received token value
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Debugging a recipe (or python script)
+

* A recipe/python-script may fail due to several cases: wrong
Input data/parameters, sw implementation bugs...

* To catch a recipe failure be sure to set the recipe failure
mode to “Ask” or “Stop”.

Recipe Failure Mode: $RecipeFailureMode

-
Continue
Stop
Ask

e debugging by using command line:

> cd reflex_book_keeping/<instrume>/recipe_name
~ execute: ./cmdline.sh

You may set “Run on terminal” option to debug a Python
actor.
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Debugging: look at EsoReflex directories
+

Bookkeping Input/output SOF. Recipe
parameters.DataOrganization
Interactive workflows

Logs Recipe output logs

Tmp_Products Recipe execution products
(FITS files)

End_ Products Final scientific products with

meaningful names
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